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WORD FOR POWER USERS

USING MAIL MERGE

1 OF 7 (1-3 MAIL MERGING)

Word contains a mail merge facility that allows you to quickly produce multiple personalized versions of a document for distribution to a large number of people.  A mail merge involves merging a main (sample) document with a data source so that multiple copies of the document are created, each one containing different information extracted from the data source.  Mail merge documents can be 

• form letters

• mailing labels

• envelopes

• catalogs

You can print the merged documents or merge them to an e-mail editor that allows you to send them as e-mail messages.  The Mail Merge Helper is the tool you use to create the main documents, organize and merge data about the recipients, and print the results.  Using the Mail Merge Helper, you create a main document - that is, the sample document that you want to send to multiple recipients.  Then you create merge fields in the document - that is, place markers for the personalized information for each recipient.  When you have created a main document, you can access a data source, such as an address book or an Excel worksheet, using the Mail Merge Helper.  The Helper then extracts information from the data source, for example the last name and address of each person in an address book such as an Outlook address book or a Microsoft Exchange Server address book.  And it makes multiple personalized copies of the main document, placing the data specific to each recipient in a separate copy of the document in the appropriate merge fields.  The process of placing personalized data in multiple copies of a document is known as mail merging.  The Mail Merge Helper enables you to create or open a data source containing the personalized information for each document.  Besides an address book, you can use the following as data sources:

• existing Excel spreadsheets

• a Microsoft Access database

• an ASCII text file

• a Word table 

If you haven't set up a data source containing the information for the merged documents, Word helps you to create a Word table containing the information you need.  When you create a Word table as a data source, you can choose your own header fields in the Create Data Source dialog box.  You can remove a field name from the table by selecting it, for example First name, and then clicking Remove Field Name.  You can also add a field name by typing it in the Field name text box and clicking the Add Field Name button.  You can change the order in which the fields appear in the header row of the table by clicking the up or down directional arrows.  When you merge the main document with the data records, you can

• specify which data to merge

• preview the merged   documents to check for errors

• edit the fields in the  resulting documents

You may want to merge data from an external data source, for example a dBASE file, with your main document.  If this is the case, you can use Microsoft Query, which is supplied with Office.  You may need to install Microsoft Query from the Office 2000 CD or check with your administrator if it is not available on your computer.  You can use MS Query by opening the Mail Merge Helper and clicking the MS Query button in the Open Data Source or Create Data Source dialog boxes.  You can then choose a data source option, for example dBASE, from the list on the Databases tabbed page.
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When you create the main document, for example for a form letter, you need to create merge fields in the main document to act as placeholders for the data.  The merge fields enable Word to place data from a data source in specific places in individual documents.  For example, if you use a Word table as a data source, the merge fields in your document match the header fields in the table.   You can add Word command fields to the document in the same way as you add merge fields by clicking the Insert Word Field button.  The command fields available in mail merge documents include the

• Ask and Fill-in fields

• If…Then…Else fields

• Merge Record and Merge Sequence fields

• Next Record and Next Record If fields

• Set Bookmark field

• Skip Record If field

The Ask and Fill-in fields allow you to place information in merged documents when it does not appear in a data source.  If, for example, you want to add personal notes to some customers' documents, you place an Ask or a Fill-in field in the main document and Word displays a prompt every time a new data record is merged with the main document.  You can then choose to fill in a comment or dismiss the prompt.  If you want to be able to print the final document, it is better to use a Fill-in field to add information to the document because Ask fields can only be printed if you create a bookmark under the Ask field in the main document.  The If…Then…Else field allows you to specify instructions according to the details in individual documents.  For example, you may want to ask the recipients of a form letter in Los Angeles to respond by telephone.  You do this by selecting City in the Field name text box, Equal to in the Comparison text box, and typing Los Angeles in the Compare to text box.  You type Please call our headquarters in the Insert this text text box and Please return the enclosed form in the Otherwise insert this text text box.  Word interprets this to mean that it should print the first sentence if the letter is addressed to someone in Los Angeles and it should print the second sentence in all other cases.  The Merge Record and Merge Sequence fields keep track of merged data when it is included in documents.  The Merge Record field contains the number of the record in its original data source, for example invoice 30 of 45.  The Merge Sequence field records the order in which records are merged with the main document, so invoice 30 may be merged record 01.  You can use the Next and NextIf fields to set conditions for merging the specific data records with the main document.  Although you can use the NextIf field to select data records you want to merge, it is easier to use the Query Options facility in the Mail Merge Helper to carry out this task.  For example, if you are sending off a set of late accounts, you may specify that only those data records containing a Status Equal to Unpaid should be merged with the main document.  The Set field assigns the text or number value of your choice to a bookmark.  Bookmarks act as placeholders and refer to a section of text or a location in a document.You can give a bookmark any name of your choice.  For example, if you define a bookmark value as {SET Overdue "$100"} in the main document, then every time the bookmark {Overdue} appears in the document, the value $100 will be displayed in the merged documents.  You can repeat a bookmark as many times as you like in the main document.  You can also use a bookmark as part of If fields and formula fields in your main document.  Using the Skip Record If field, you set field values that cause the mail merge to skip certain data records.  For example, if the Last name field contains the name Smith, then the mail merge skips that record and merges the next data record with the main document instead.
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You can sort the data records in the data source so that they are merged with the main documents in a specific order.  For example, you may select only customers with the last name Smith from your data source and then sort the names according to the companies in the source address list.  Word allows you to use both words and numbers when you select records so you can, for example, use postal codes to make a selection.  Word also provides And and Or options so that you can specify more than one set of selection criteria for your mail merge.  You use the Sort Records tabbed page in the Query Options dialog box to sort the data in your data source for a mail merge.  The sorting criteria determine the order of priority for the merge and for printing.  You can select up to three levels of sorting criteria on the Sort Records tabbed page using the Sort by text box and the two Then by text boxes.  Word stores the selection criteria and the sort order in the main document and retrieves the data records according to these criteria every time that you open the document.  If you want to change the selection criteria or the sort order in the main document, you need to access the Mail Merge Helper and change the selection or sorting criteria using the Query Options button.  If you want the records to stay in the sorted order when you quit Word, you need to save the data source before you close the main document.  If you use a Word data source and you specify selection and sorting criteria, Word sorts all the data records regardless of whether they are part of the selection criteria. But when you use a non-Word data source, Word sorts only the selected data.
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The procedure for creating the main document, whether for form letters, mailing labels, envelopes, or catalogs, is similar.  If you want to use a form letter, you can open an existing letter or create a new letter.  Then you select Tools - Mail Merge.  If you want to create mailing labels, envelopes, or catalogs, you click the New Blank Document button on the Standard toolbar.And you select Tools - Mail Merge.  In the Mail Merge Helper dialog box you click Create in the Main document section.  Then you select Form Letters from the drop-down list.  Word prompts you to use the document in the active window as the main document or create a new document and, in this case, you click Active Window to use the open document.  The active document then becomes the main document for the mail merge and you are returned to the Mail Merge Helper dialog box.
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Let's say that you have created a letter to accompany a promotional copy of Award Sportswear's new mail catalog.  To access the data for the mail merge, you click the Get Data button in the Data source section of the Mail Merge Helper dialog box.  In this case you choose to create a new data source so you select Create Data Source from the menu.  This guides you through creating a Word table as a data source.  In the Create Data Source dialog box you set the field names for the Word table as you want them and you click OK.  The Save As dialog box appears and you select a location in which to save the file, in this case the Catalog Advertising folder.  Then you type a name for the new data file, in this case CatTable1.doc, and you click Save.   You always save Word tables as Word documents with the extension .doc.You can access the file through Word in the usual way to edit it.  When you have saved the new Word table as a data source, Word prompts you to add data to the table and you click Edit Data Source.   When you have added all the necessary data to the table in the Data Form dialog box, you click OK.  Once you have created a main document for a mail merge and opened your data source, you need to insert merge fields in the document as place markers for your data records.  You can insert fields from your data source into the main document by clicking the Insert Merge Field button on the Mail Merge toolbar.  To add a merge field to the document, you place the insertion point where you want the field to appear and you select a field, in this case Title, from the list.  When you have created the main document for a form letter and entered the merge fields in the document, you can carry out your mail merge.  You click the Merge button in the Mail Merge Helper dialog box to complete the mail merge.  If you are creating a form letter, a mailing list, or a set of envelopes, you can choose to merge to a new document, to print the document, or to merge it to e-mail.  But if you are creating a catalog or a similar document, you need to select New document from the Merge to drop-down list because you cannot merge this type of document directly to a printer or e-mail.  If you want to print the merged catalog, you need to do so after the merge is completed by clicking the Print button on the Standard toolbar.  You can set selection criteria for a merge in the Records to be merged section by selecting the From radio button and typing a selection in the From and To text boxes.  You can also click the Check Errors button to preview the merged documents and check for errors before completing the merge.  When you have completed all the settings for your merge, you click Merge.  And the merged documents are displayed, printed, or sent using e-mail.
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Let's say that you have created the main document for a form letter and you want to use an existing data source for a mail merge.  But you also want to set bookmarks in your main document and you want to use selected records from the data source for your mail merge.  When you have finished creating a new data source, you return to the Mail Merge Helper dialog box and you click Get Data.  Then you select Open Data Source to open the new data source.  You can use the Use Address Book option to use an address book as the data source and the Header Options option to edit the header fields in the data source.You can also edit the new table at any time by clicking the Edit button in the Data Source field of the Mail Merge Helper dialog box.  When you choose to open an existing data source, the Open Data Source dialog box appears so that you can select the file you want, in this case CatTable1.doc, and you click Open.  Word now prompts you to make changes to the main document and you click Edit Main Document.  The main document appears on screen with the Mail Merge toolbar visible so that you can add fields to it.  Instead of using the Mail Merge Helper to create a form letter, you can use the Letter Wizard provided with Word. You can use the form letter produced by the wizard as the main document for a mail merge using the Mail Merge Helper in the same way as for other documents.  You add first name and last name merge fields to the document but you want to place a bookmark in the main document as well.  To do this, you select Insert Word Fields - Set Bookmark.  Then you enter a name for your bookmark, in this case Discount, and you type the text or numbers you want to appear where you place the bookmark, in this case 10%.  When you have set your bookmark name and value, you click OK to return to the document.  Then you place the insertion point in the place where you want the bookmark to appear and you press Ctrl+F9 to insert field markers in the document.  You type the name of the bookmark, in this case Discount, between the field markers, and the bookmark is ready to appear in the merged document.
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Suppose that you have completed the field settings for the main document of a form letter and you now want to sort and select the data to be merged with it.  To select and sort data, you first place the insertion point anywhere in the main document and select Tools - Mail Merge to open the Mail Merge Helper.  Then you click the Query Options button in the Merge the data with the document section of the Mail Merge Helper.  To select specific records for the mail merge, you select a field, for example LastName, from the Field drop-down list on the Filter Records tabbed page.  Then you select an option from the Comparison drop-down list, for example Equal to, to determine the rules that are used for the selection.  And you type the relevant words or numbers from the chosen field into the Compare to text box, for example Jones.  Let's say you want to send a document to all salespeople in the source list and to all customers in Chicago, so you select Department and Equal to and you type Sales.  Then you select Or to ensure that Word will only choose documents containing the location Chicago if the Department field does not contain the word Sales.  You select City and Equal to and type Chicago to complete the selection.  To sort the data records for the mail merge, you click the Sort Records tab.  Then you select the sorting criteria, in this case LastName from the Sort by drop-down list and Company from the Then by drop-down list.  You leave the default Ascending radio button selected in both cases so that the records will be sorted in ascending order starting with last names with an initial letter A.   When you have completed the selection and sorting settings, you click OK to close the dialog box and return to the Mail Merge Helper.  And in the Mail Merge Helper dialog box you click Merge to merge the sorted data records with the main document.

END OF USING MAIL MERGE

SUMMARY

You have seen how to use the mail merge function in Word 2000.  

The mail merge function in Word allows you to create generic documents that are sent to multiple recipients. You can add personalized information to the generic documents using the Mail Merge Helper.  You can create generic documents for form letters, envelopes, mailing labels, and catalogs using mail merge. You can also import personalized data from various sources or create a source document from which to extract data for the merge.   When you create the main document for a mail merge, you need to add merge fields to the document as place markers for the data that will be merged with it. When you merge the document with the data, you can also specify which records from the data source are merged and you can sort them in the order you prefer.  If you want to access a data source on a network, you need to install Microsoft Query on your computer. This makes it possible to access foreign data sources and merge them with a Word document.  You can place the fields from your data source at any place in the main document when you perform a mail merge. You can also use various Word fields to create specifications for your mail merge. For example, you can select some data to be merged and other data to be discarded using the If…Then field.  When you merge the data source with the main document, you can make a further selection of the data that is merged with the document. You can also choose to preview the mail merge so that you can check for errors in the merge.  You can use the Mail Merge Helper to select and sort data records for your mail merge. You can select documents based on the contents of the data source fields and you can sort the selection alphabetically when you merge the data.

UNIT TEST:

1. Is the following statement true or false?

You can use mail merge to distribute an e-mail message.

a. True

b. False

2. Which of the following are valid mail merge data sources?

a. A Word document

b. An ASCII text file

c. An Access database

d. An Outlook address book

3. You use _____ to access a data source on a network for a mail merge.

a. MS Project

b. MS Query

c. Publisher

d. Outlook

4. Which of the following Word fields allow you to enter personalized information into merged documents?

a. Ask

b. Fill-in

c. Merge sequence

d. Merge record

5. Which of the following Word fields allow you to select data records to be merged with the main document?

a. Fill in

b. Merge Record

c. If ... Then ... Else

d. Skip Record If

6. Is the following statement true or false?

You need to use alphabetic text fields as the criteria for selecting data records.

a. True

b. False

7. Is the following statement true or false?

You can use an existing letter as the main document for a form letter.

a. True

b. False

8. Which of the following is true of using a data source for a mail merge?

a. You need to create a data source before you begin the merge procedure

b. You can create a data source while performing a mail merge

c. You need to define the data source fields before you begin the merge procedure

d. You need not use a data source for a mail merge

9. Is the following statement true or false?

When you insert a bookmark for a mail merge, the bookmark value appears in the main document before the merge.

a. True

b. False

10. Which of the following are true of performing a mail merge?

a. Once you have selected data records for the merge, you cannot alter the selection

b. You use the Mail Merge Helper to sort data records

c. You can select two different criteria when selecting records for a single mail merge

d. When you perform the merge, the results are automatically printed

ANSWERS:

1. True

2. a, b, c & d

3. b

4. a & b

5. c & d

6. False***

7. True

8. b

9. False***

10. b & c

WORD FOR POWER USERS

FORMS AND FIELDS

1 OF 8 (1-5 FORMS)

Forms are Word documents with interactive features that allow you to collect information from users.  Using Word you can create both on-screen forms and forms that users can print and then complete.  The benefits of using on-screen forms instead of printed forms include

• an automatic verification of user input

• automatic field updates when a user   chooses a particular option

• the association between on-screen   forms and on-screen help messages

When you create on-screen forms, you can base them on existing documents or on an existing or new template.   Whichever method you choose, it's advisable to plan your form on paper first so you know what form elements to include and how to lay them out on the page.  You can use visible or hidden tables, text boxes, graphics, frames, drop-down lists, and checkboxes.   And you can apply all text and paragraph formatting that is available in a normal document.  You can associate macros with form options to perform actions based on a user's input.  For example, if a user selects a city from a drop-down list, a macro can activate related fields - such as a country or a zip code field - which the user then completes.  To save a user's input, you can save the results or you can have the user print out the form.  When the form is saved, it is saved as a text file, which can be added to a database.  When the document is printed, only the data the user entered in the form is printed.
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Let's say that you want to create a form to collect information from customers.  You want to base it on an existing document template.  To base the form on an existing template, you select the File menu.  Then you select the New option.  In the New dialog box you select a template - in this case the Blank Document template.  You select the Template radio button in the Create New section and you click the OK button.  The new blank template - called Template1 - is then created.  You save the current file as a template by clicking the Save button.  In the Save As dialog box you see that the default location for templates is the Templates folder.  In Windows 95 and Windows 98, the default folder is the Program Files/Microsoft Office/Templates folder. In Windows NT the default folder is the Winnt/Profiles/<Current user's folder>/Templates folder.  In the Templates folder you can create a folder in which to store the template - for example a Forms folder - and you type a name for the template - in this case Catalog.dot.  Then you click the Save button to save the template.  And the new template is ready for you to customize.
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You create simple forms using the Forms toolbar.  To open the Forms toolbar, you right-click an existing toolbar and you select Forms from the shortcut menu.  You can also choose Toolbars - Forms from the View menu.  You can dock the toolbar to keep your view of the document clear.  The Forms toolbar allows you to draw a frame in which you add fields.  You can also use the Control Toolbox toolbar.  The Control Toolbox toolbar allows you to insert more options than the Forms toolbar - for example you can use radio buttons, list boxes, and images.  To draw a frame, you click the Insert Frame button on the Forms toolbar.  And then you click the page and drag the frame to the size you require.  Let's say that you want to draw a table in the frame to control the alignment of the form's fields.  To do this, you click the Insert Table button on the Forms toolbar.  Then you specify the number of rows and columns you want in the table - in this case you choose a table with eight columns and five rows.  The table is inserted in the form.  And you can then customize it using the Tables and Borders toolbar.  The Tables and Borders toolbar can be opened by right-clicking any existing toolbar and selecting Tables and Borders.You can then dock the toolbar.  For example, you can insert rows and columns, align text within cells, and split or merge cells.
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Let's say that you have designed your form and you now want to add text fields to the form.  To add a field - in this case the First Name field - you click the cell in which you want the field placed and then you click the Text Form Field button.  This inserts a gray text field.  To edit the properties of a text form field, you click the Form Field Options button.  You can also edit the field's properties by double-clicking the field.  This opens the Text Form Field Options dialog box.  You can specify that a text field accepts either text, numbers, or dates by selecting an option from the Type drop-down list.  You can enter text in the Default text text box if you want to guide a user's input with sample text displayed in the form field.  The Maximum length spin box allows you to specify the maximum number of characters that a user can input.  And the Text format drop-down list allows you to specify the format in which you want the text displayed.  The Run macro on section allows you to choose existing macros to run when the field is entered and when the field is exited.  The Bookmark text box in the Field settings section allows you to provide a name to bookmark the field.  The Calculate on exit checkbox updates and recalculates fields that have calculation formulae when a user exits the current form field.  And the Fill-in enabled checkbox allows you to permit or prevent users entering any data in the current field.   In this case you accept the default data type and you change the maximum length to 15.  And you choose First capital from the Text format drop-down list to capitalize the first letter of any text entered by a user.  You can add help text to a field by clicking the Add Help Text button.  And you can opt to add text to the status bar as well as to the Help (F1) key.  The AutoText entry radio button uses an AutoText entry to create a help message.  To add your own help information, you select the Type your own radio button and you type the message in the field below.  You can use only 138 characters in a status bar help message.  Then you click OK to close the dialog box.  When you have finished specifying the properties of the text form field, you click OK to return to the form.
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You can insert drop-down lists and checkboxes on a form.  You can also either display or hide the gray shading on form fields.  And you can protect the document from being inadvertently or consciously changed.   To insert a drop-down list, you click the Drop Down Form Field button.  You double-click the field to open its properties.  And this opens the Drop-Down Form Field Options dialog box.  To add an option to the drop-down list, you type the option in the Drop-down item text box - in this case Credit card - and then you click the Add button.  The option is then added to the Items in drop-down list list box.  You add all the options you require in the drop-down list.  To move options in the list, you select the option and click the relevant up or down Move button - in this case you move the Check option to the top of the list.  You can remove options from the list.  To do this, you select the option and you click the Remove button.  When you have finished specifying your drop-down list options, you click OK to close the dialog box.  To hide and display form field shading, you click the Form Field Shading button.  The shading is no longer visible on the form.  When you have completed your form, you prevent users from changing the fields or their properties by clicking the Protect Form button.
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Fields are used in documents as placeholders for data that changes, such as the current date and time or a document's file location.   They are used to create form letters and labels in mail mergers as well as to create tables of contents.  Fields contain field codes and field results, making them similar to formulas in Microsoft Excel.  Fields codes are similar to the formulas that govern how data is interpreted.  They appear in documents between braces - {}.   Field results are similar to the values that a formula produces when acting on data.  Some of the most common field codes include date and time fields - such as the date or time the file was created, printed, saved, or edited.   You can also include information about the document - such as the author's name, the filename, file size, and keywords.  And you can include user information - such as the user's address, initials, and name.
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Let's say that you want to include fields in a document.  You want to add document information to the first page's footer - such as the filename and location - as well as the date and time the document was created.  You open the document's footers by selecting View - Header and Footer.  You can dock the Header and Footer toolbar so that it doesn't obstruct your view of the document.  Then you click the Switch Between Header and Footer button on the Header and Footer toolbar to move from the header to the footer.  And the first page's footer - which is currently empty - is displayed.  You type appropriate text to prefix the field.  And then you select Insert - Field to insert field codes.  The Field dialog box contains all available fields you can use in a document.  The Categories list box groups fields into categories, including Date and Time, Document Information, and Equations and Formulas.  You select a category - in this case the Document Information option - and different fields are then displayed in the Field names list box, for example the author's name or the file's size.  You select the FileName option from the list box and you see that the Field codes text box is updated with the relevant code syntax.  To customize fields, you click the Options button.  The contents of the Field Options dialog box vary with the field chosen, but they all add switches, operators, and other instructions to the field.  To display the filename of your document with each word having an initial capital, you select the Title case option from the Formatting list box.  And to add the title case switch to the field, you click the Add to Field button.  You can add switches that are specific to the FileName field by clicking the Field Specific Switches tab.  In this case a switch that adds the system's path to the file is available so you select the option and click the Add to Field button.  And then you click OK to close the dialog box.  You see that the Field codes text box is updated and includes both new switches.  You choose to retain any formatting applied to the field results by ensuring the Preserve formatting during updates checkbox is selected.  And then you click OK.  The field is added to the footer and the field results are displayed.  To see or hide the field codes, you press Alt+F9 on the keyboard.  You can also right-click the field and select the Toggle Field Codes option.
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By default, fields are shaded gray.  Although Word does not print the shading, you can remove the shading by selecting Options from the Tools menu.  On the View tabbed page you click the Field shading down-pointing arrow.  You can choose to always or never display gray shading.  Or - as in this case - you can choose to display shading when the field is selected.  When you've made your selection, you click OK to close the dialog box.  Sometimes Word may print the field codes instead of the information in the field.  To prevent this, you select Tools - Options.  Then you click the Print tab.   On the Print tabbed page you need to click the Field codes checkbox to clear it.   And then you click OK.  If the information in the field is outdated or incorrect, you may need to refresh the field.  To do this, you press F9 on the keyboard.  Or you right-click the field and select Update Field from the shortcut menu.

END OF FORMS AND FIELDS

SUMMARY:

You have seen how to create and modify forms and fields.  Forms allow you to collect information from users. You can create on-screen forms as well as forms that users print and then complete. However, the benefits of on-screen forms include an automatic verification of user input, automatic field updates when a user chooses a particular option, and  the association between forms and on-screen  help messages.  When you create on-screen forms, you can base them on existing documents or on an existing template. You can use visible or hidden tables, text boxes, frames, drop-down lists, and checkboxes. You can also associate form options with macros that perform actions based on a user's input.  Fields are used in documents as placeholders for data that changes, such as the current date and time or a document's file location. Fields are used to create form letters and labels in mail mergers,  but the most common use of fields is for  numbering pages.  Fields contain field codes and field results, making them similar to formulas in Microsoft Excel. Field codes are similar to the formulas that govern how data is interpreted. They appear in documents between braces - {}. Field results are similar to the values that a formula produces when acting on data.

UNIT TEST:

1. When you create on-screen forms, you can base them only on existing documents.

a. True

b. False

2. When a form is saved, it is saved as a _____ file.

a. text

b. database

c. Word

d. HTML

3. You can associate _____ with form options to perform actions based on a user’s input.

a. hyperlinks

b. entries

c. macros

d. documents

4. A field _____ is similar to a formula that determines how data is represented, while a field _____ is similar to the value a formula produces.

a. code

b. result

5. Fields appear between square brackets.

a. True

b. False

6. Which of the following can you choose to do when using fields?

a. Preserve field formatting during updates

b. Print the field codes with your document

c. Have fields displayed with a shading color of your choice

d. Have fields displayed with no shading

7. In which of the following ways can fields be used in Word?

a. As placeholders for data that changes, such as the current date

b. To create form letters

c. To create labels for mail merges

d. To store data imported from Excel

ANSWERS:

1. False

2. a***

3. c

4. 1st blank: code, 2nd blank: result

5. False

6. a, b & d***

7. a, b & c

WORD FOR POWER USERS

MACROS AND TOOLBARS

1 OF 6 (1-4 USING MACROS)

If you perform the same task repeatedly in Word documents, you can create a macro to perform the task for you.  Macros are often used to speed up routine formatting tasks and automate complex tasks.  A macro is a combination of a series of steps that can be activated as a single command.  For example, you can create a macro to access the Font tabbed page of the Font dialog box and change the color of the selected text to blue.  This means that you activate one macro instead of performing all the steps every time you want to change the text color to blue.  If you want to publish a Word document as a web page, you can use the Microsoft Script Editor to automate tasks instead of macros.  Word contains a macro recorder that records the steps for a macro in Visual Basic code.  It also contains an option called Project NewMacros - a Visual Basic script that stores all the macros that a user creates for a particular document as subroutines.  Although the macro recorder can record mouse clicks, it cannot record mouse movements, such as selecting a piece of text.  If you want to record selecting, copying, or dragging items as part of your macro, you need to use the keyboard shortcuts for these steps.  If you know Visual Basic code, you can create a new macro by selecting Tools - Macro - Visual Basic Editor and typing the code for the new macro.  You can access a macro by selecting Tools - Macro - Macros.  You can then run the macro by choosing it from the list in the Macros dialog box and clicking the Run button.  You can run a macro without using the Macro submenu if you assign the macro to a toolbar button, a menu option, or a shortcut key when you record it.  You run the macro simply by clicking the assigned toolbar button or menu option, or pressing a shortcut key.   You can store macros in document templates or in specific documents.  Word stores macros in the Normal template by default so that the macros are available for use in all documents.  If you want to store a macro in a single document, you store it as a macro project, which can be copied to other documents if you need it.  You can copy and rename macros using the Macro Organizer.  You can also use the Visual Basic Editor to change the steps in existing macros.
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Suppose that you want to create a macro that will change the selected text to blue, underline it, and make it bold.  To do this, you select the Tools menu.  And you select Macro - Record New Macro.  The New Macro dialog box appears on screen and you type a name for the macro, for example BlueBold, in the Macro name text box.  And you select a template or document in which to store the macro, for example Progress Report.doc, from the Store macro in text box.  The default selection is to store the new macro in the Normal template so that it can be applied to all Word documents.  You can also type a description of the macro, for example Change text to blue, in the Description text box.  If you want to assign the new macro to a toolbar or menu, you click the Toolbars button.  Or if you want to assign it to a shortcut, you click the Keyboard button.  If you don't want to assign the macro to a toolbar, menu, or shortcut, you click OK in the New Macro dialog box to begin recording the macro.  If you want to assign the macro to a toolbar or menu, you select the macro in the Commands dialog box and you drag it to the toolbar or menu that you want to assign it to, in this case the Format menu.  The macro, in this case BlueBold, is automatically saved as part of the NewMacros project in the document so it is named Project.NewMacros.BlueBold in the Commands dialog box.  The menu opens automatically and you release the mouse button at the position on the menu where you want the macro command to appear.  If you want to assign a keyboard shortcut to a macro, you select the macro, press the shortcut keys - always Alt+<key> - and you click Assign.  If you press the shortcut keys, Word automatically enters the typed letters in the Press shortcut keys text box.  When you have assigned the macro to a toolbar, menu, or shortcut, you click Close to begin recording it.  The Recording toolbar appears on the screen to indicate that recording has started and you carry out the steps that you want to record.  In this case you select Format - Font to begin.  In the Font dialog box, you select Bold from the Font style list.  Then you click the Font color down-pointing arrow and you select Blue.  To ensure that the text is underlined, you click the Underline style down-pointing arrow.  And you select the style you want to use, in this case a single line, from the drop-down list.  You click OK to complete the format settings for the selected text.  All the steps you have carried out form part of the macro you are recording.  To stop recording the macro, you click the Stop Recording button.  You can stop recording partway through your macro and resume recording again later by clicking the Pause Recording and Resume Recorder buttons on the Recording toolbar.  http://www.microsoft.com/mspress/books/sampchap/2061.asp 
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Let's say that you want to run the BlueBold macro that you've created on a piece of selected text.  To run the macro, you select the Format menu because you assigned the macro to it.  And you select Project.NewMacros.BlueBold.  The formatting steps contained in the macro are now applied to the selected text.  Suppose that you no longer want the macro to underline the text so you decide to edit the Visual Basic code to change the underline setting.  To begin, you select Tools - Macro.  Then you select the Macros option.  You can also edit your macro by selecting Visual Basic Editor and choosing your macro from the drop-down list in the Visual Basic Editor dialog box.If the Macro you are looking for is not in the Macro name text box, you need to select a different document or template name from the Macro in text box.  In the Macros dialog box, you select the name of the macro you want to edit, in this case BlueBold, and you click Edit.  If you access the macro code using the Tools - Macro - Visual Basic Editor option, you may need to select the template or document in which the macro is saved in the Projects list box first.If this happens, you select Modules and then NewMacros from the template or document submenu and then select the macro you want from the NewMacros project list.  The code for the macro is then displayed in the Visual Basic Editor dialog box.  The fact that the macro is stored as part of the NewMacros project in the document is reflected in the words [NewMacros (Code)] after the filename in the title bar.  To edit your macro, you can delete unnecessary steps or change the value of a command in the code.  For example, to ensure that the BlueBold macro no longer underlines text, you select the word wdUnderlineSingle.  And you type False to negate the Underline command.  When you have made all the desired changes to the macro, you click the Close button.  And the next time you apply the macro to a piece of text, the changes are applied automatically.  While some changes to the Visual Basic code are quite simple, it is sometimes easier to delete the macro and rerecord it, especially if you want to make a number of changes.  If you want to delete a macro, you select Tools - Macro.  And you select Macros.  You select the name of the macro you want to delete, in this case TitleText, in the Macro name text box and you click Delete.  Then you click Yes to delete the macro.  If you want to delete multiple macros, you select all those you want to delete and you click Delete.If the macro you want to delete does not appear in the Macro name text box, you can try selecting a different document or template from the Macro in text box.
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Let's say that you decide to copy the BlueBold macro from the Progress Report.doc to a new document called Progress Report 2.doc.  To begin, you select the Tools menu.  And you select the Templates and Add-Ins option.  In the Templates and Add-Ins dialog box the name of the current document template appears in the Document template text box.  You can change the selected template by clicking the Attach button and selecting another template from the list that is displayed.  But the template you choose needs to be available in the document you have open at the time.  To select the macro you want to copy, you click Organizer.   You can also access the Organizer by selecting Tools - Macro - Macros and clicking the Organizer button in the Macros dialog box.  And in the Organizer dialog box you click the Macro Project Items tab.  On the Macro Project Items tabbed page the name of the current document appears in the In text box label by default.  And Normal.dot appears as the default in the To text box label.  Because you do not want to copy the macro to the Normal.dot template, you click the Close File button below the To text box label to close the template.  The Open File button then appears and you click it to open the document to which you want to copy the macro.  In the Open dialog box you select the name of the file to which you want to copy the macro, in this case Progress Report 2.doc, and you click Open.  You are returned to the Macro Project Items tabbed page where you select the NewMacros project in the In Progress Report.doc text box and you click Copy.  If you want to copy a macro from a template or file other than the one you have open, you click Close File to close the current document.The Open File button appears and you click it to open the template or file you want to copy the macro from.  The NewMacros project containing the BlueBold macro is now copied to the To Progress Report 2.doc text box.  When you have completed all the changes to your documents, you click Close to return to the open document.

5 OF 6 (5-6 CUSTOMIZING TOOLBARS)

You can create new toolbars in Word documents using commands from existing toolbars and menus.  You can also add macro command buttons to existing toolbars and menus.  You can save the new toolbar in your current document or in a document template for use in other documents.  You can also customize existing toolbars by adding or deleting buttons on them.  Suppose that you decide to create a new toolbar so that you can access certain formatting functions more easily.  To begin, you select the Tools menu.  And you select Customize.  On the Toolbars tabbed page of the Customize dialog box you click New.  Then you type the name of the new toolbar, in this case TextForm, in the Toolbar name text box.  And you select a template or document from the Make toolbar available to drop-down list - in this case you accept the default, Normal.dot.  If you add a new toolbar to the Normal template, it becomes available in any Word document you open.  When you have named your new toolbar, you click OK.   And the new toolbar appears on screen so that you can add buttons to it.  To add buttons to the new toolbar, you click the Commands tab.  On the Commands tabbed page you select a menu from the Categories drop-down list, in this case Format, to view its options.  And you select an option, in this case Bold, to add to the toolbar.  To add the selected option to the new toolbar, you drag it to the toolbar.  You can add multiple options from a menu to the toolbar.  And you can add options from other menus to the toolbar as well.  When you have added all the required buttons to your new toolbar, you click Close.  If you want to add buttons to any toolbar, you can do so by making the toolbar visible and then dragging commands onto it using the same procedure that you use for creating a new toolbar.  Let's say that you want to delete a button from a custom toolbar.  To display your toolbar, you first select View - Toolbars.  And you select the relevant toolbar, in this case TextForm, from the menu.  When the toolbar appears on screen, you press the Alt key.  While holding down the key, you click the button you want to delete, in this case the Italics button, and you drag it off the toolbar.  The button no longer appears on the toolbar.
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Suppose that you want to add or remove buttons from a built-in toolbar without using the Tools - Customize option.  To do this, you click the More Buttons button on the Standard toolbar.  And you select Add or Remove Buttons from the drop-down box.  From the Add or Remove Buttons drop-down menu you select a button you want to remove from the toolbar, for example the Show All button.  The Show All button is now deselected on the list and it no longer appears on the toolbar.  To view the rest of the options in the Add or Remove Buttons menu, you click the down-pointing arrow.  To add a button, for example the Close button to the Standard toolbar, you select the button from the menu.  And the button appears on the Standard toolbar.  END OF MACROS AND TOOLBARS

SUMMARY:

You have seen how to use macros and customize toolbars in your document.  

Word allows you to create macros that reduce a number of steps into a single command. You can use macros if you want to simplify or automate a multistep task that you often perform. You can store a macro in an individual document or in a template for use in other documents.  Macros are recorded in Visual Basic code. Once you have recorded a macro, you can edit it using the Visual Basic Editor. You can also copy macros to other documents, rename them, and delete them whenever you wish.  Word allows you to create custom toolbars in your documents or templates. You can add commands from existing menus and toolbars to custom toolbars. You can also edit existing toolbars to add or delete buttons from them.

UNIT TEST:

1. Which of the following statements apply to recording macros in Word?

a. You can store macros in individual document templates

b. You can record any mouse movement for a macro

c. A macro’s steps are recorded in Visual Basic code

d. You can assign shortcut keys to a macro

2. Is the following statement true or false?

You can place a macro on a toolbar.

a. True

b. False

3. For which of the following do you use the Word Organizer?

a. Moving or copying macro projects

b. Deleting macro projects

c. Editing macro projects

d. Renaming macro projects

4. Which of the following is true of customizing toolbars?

a. You can use buttons from existing toolbars on a new toolbar

b. New toolbars need to be stored in the current document

c. You can use buttons from more than one existing menu in a new toolbar

d. You can add buttons to a docked toolbar

5. Is the following statement true or false?

You cannot remove buttons from existing toolbars.

a. True

b. False

ANSWERS:

1. a, c & d

2. True

3. a & d***

4. a, c & d

5. False

WORD FOR POWER USERS

COLLABORATING WITH WORKGROUPS

1 OF 12 (1-3 COMMENTS)

If you work in a collaborative workgroup environment, you may frequently want to review and comment upon documents drafted by others.  Using comments, you can add notes, suggestions, and queries to Word documents without changing the original text.   You can insert both text comments and sound comments in any Word document.   When a comment is added, Word marks the comment in both the body of the document and the comment pane with a number and the initials of the current user.   To edit the information in the User Information dialog box, you choose Tools - Options and you click the User Information tab.   The reference number is placed beside the commented text, which is highlighted in yellow.  When the pointer is hovered over the highlighted text, the comment is displayed in a screentip.   If you want to view all the comments in a document at the same time, you use the comment pane.  You click the Comments From down-pointing arrow in the comment pane to display all reviewers' comments or to see comments made by a particular reviewer.  In the comment pane you can move and edit comments.  However, you cannot delete a comment in the comment pane since this can only be done in the document itself or by using the Reviewing toolbar.  You open the Reviewing toolbar by right-clicking an existing toolbar and selecting Reviewing from the shortcut menu.  On the Reviewing toolbar you see that you can 

• add a comment

• edit a comment

• move to the previous or  next comment

• delete a comment
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Let's say that you are reviewing a document and you want to add comments to it.  To do this, you select the word you want to comment on - in this case formed.  Then you select Insert - Comment.  The comment reference is added to the body of the document and the comment pane opens.  To add a comment, you type the comment in the comment pane.  And you hover the pointer over the comment to display the screentip that contains the comment.  Word allows you to quickly navigate through your comments.  To move to the previous comment, you click the Previous Comment button.  And you can move to subsequent comments using the Next Comment button.  You click the Delete Comment button to remove a comment.  And you see that Word removes the yellow highlight from the text and the comments are renumbered accordingly.  If there are multiple comments and you delete one, the comments will be renumbered accordingly.  If there is only one comment, the comment pane closes.
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You can insert voice comments in a document if your computer has a sound card, speakers, and microphone.  To insert a voice comment, you select the text you want to comment on and you click the Insert Sound Object button.  This opens the Sound Object dialog box.  You click the Record button to start recording your comment.  And you click the Stop button when you finish your comment.  To close the Sound Object dialog box, you click the Close button.  And the sound object icon in the document tells you that a voice comment has been inserted.  The sound recording can be played by double-clicking the icon.

4 OF 12 (4-6 SECURING DOCUMENTS)

It is sometimes important to protect your Word documents from unauthorized access and modification.  To do this, you can 

• set a password that must be   entered in order to open   a document

• set a password that must be   entered in order to modify   a document

• make a document read only

The password you use to secure a document from being opened or edited is case sensitive.  It can include letters, numbers, and symbols but can contain no more than 15 characters.  If you save your Word document as a web page, any password protection that you've applied to the document is lost.  The read-only option allows you to specify that when the file opens, a message be displayed recommending that the document be opened as read-only.  When the document is opened as read only and changes to it are made, the document needs to be saved with a different name, leaving the original intact.
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Let's say that you want to apply a recommendation that the document be opened as read only.  To do this, you select File.  And then you select Save As.  In the Save As dialog box you click the Tools button.  Then you select General Options.  This opens the Save dialog box.  To recommend that the document be opened as read only, you select the Read-only recommended checkbox.  Let's say that you want to specify a password to open the document.  To do this, you type a password in the Password to open text box.  It is important to remember that if you forget or lose this password, you will not be able to open your document.  To ensure that the document cannot be edited without a password, you type a password in the Password to modify text box.  If you forget or lose this password, you can still open the document, but only as read-only.  Then you click OK to apply your changes.  In the Confirm Password dialog box, you reenter the password in the Reenter password to open text box and you click OK.  Then you reenter the password in the Reenter password to modify text box and you click OK.  In the Save As dialog box you click the Save button.  And you return to the document.
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Let's say that you want to open the document to which you've added a password and a read-only recommendation.  To do this, you click the Open button.  And you navigate to the file, select it, and click Open.  In the Password dialog box you type the password and then you click OK.  An information dialog box is displayed recommending that the file be opened as read only unless changes made to it need to be saved.  You click Yes to open the file as read only. And the file is opened for you to use.  If you need to save any changes to the document, you are prompted to save the file with a new filename.

7 OF 12 (7-10 VERSION CONTROL)

When working in workgroups that share documents, it can be difficult to keep track of different versions of the same document.  But Word allows you to create versions of documents and to use tracking to control shared documents.  Versions in Word allow you to save and manage multiple versions of a document in a single file.   When you save multiple versions of a document, you can open, print, and delete earlier versions of it.  Versions also save hard disk space because only the changes made to a document are saved when you save a version, not the whole document.  Versions are also useful if you belong to a large company and you have policy documents that require small changes for different regions.  Tracking allows you to compare an edited document with the original document by marking the differences in the edited document.  For example, in a marketing department, writers may want to keep track of editorial changes made to their documents.  You can distinguish changes made to a document by different reviewers because their changes are marked in different colors.  After viewing the changes, you can choose to accept or reject those changes.
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Let's say that you want to save a version of the current document.  To do this, you select File - Versions.  This opens the Versions dialog box and you can see that two versions of the current document already exist.  You can see in the Existing versions section of the dialog box that each version shows the time and date when it was last saved.  It also shows who saved the version.  And both versions have descriptive comments.  To view the comment for a saved version, you click the View Comments button.  In the View Comments dialog box you can read the comment that accompanies the version.  And then you click Close to close the dialog box.  You click the Delete button to delete a version.  You are asked to confirm that you want to delete the version and you click Yes to delete it.  And the version is then removed from the list.  To open a version, you select it.  And you click the Open button.  The screen is split into two windows with the older version active.  In the window of the previous version of the document you see that you have access to all Word buttons and menus allowing you, for example, to print or edit the document.  You can compare the two versions - in this case you see that an additional word has been included in the heading.  To close the older version, you click the Close button.  A document with more than one version displays the Versions icon in the status bar.  You can double-click the Versions icon to open the Versions dialog box.  You click the Save Now button to save the current state of the document as a different version.  In the Save Version dialog box you type a descriptive comment about the version and you click OK.  And you are returned to the document.
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Let's say that you share a document within a workgroup and you want to monitor the changes made to the document.  To do this, you want to use tracking so you select Tools - Track Changes.  To start tracking, you select the Highlight Changes menu option.  This opens the Highlight Changes dialog box, which allows you to mark all the changes made to the current document and to specify how those marks are displayed.   The Track changes while editing checkbox marks all the changes made to the current document and it tracks the changes made by different reviewers so you select it to start tracking.   The Highlight changes on screen checkbox displays the changes as you review the document   If you want the highlighting of all tracked changes to be visible when the document is printed, you can select the Highlight changes in printed document checkbox.  In this case you don't want the changes visible in the printed document, so you clear the checkbox.

You click the Options button to specify how different kinds of changes are displayed.  In the Track Changes dialog box you see that you can change how inserted text, deleted text, changed formatting, and changed lines appear.  From the Mark drop-down list you can select what formatting - if any - you want to use to display changes.  And from the Color drop-down list you can select a color to mark new text.  If you choose the By Author option, Word will automatically assign different colors to the first eight reviewers.  The Auto option allows you to mark new, changed, or deleted text with the default color, usually red.   And you can choose a specific color - such as Turquoise - to mark all reviewers' new text with that color.  In this case you choose to keep the default settings so you click OK.  You click OK to apply the settings to the document.  You can see that the Track Changes option on the status bar is now selected indicating that tracking is activated.
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Let's say that you are in charge of a document and you want to accept or reject changes made by other reviewers.  To do this, you select Tools - Track Changes - Accept or Reject Changes.  And the Accept or Reject Changes dialog box opens.  The default view is to view documents in which the changes are highlighted.  But if you select the Changes without highlighting radio button, the tracked changes are hidden and you can see how the document will look if you accept the changes.  The Original radio button displays the unchanged document and you can see how the document will look if you reject the changes.  You use the Find buttons to locate changes - in this case you click the forward Find button to search for the next change.  And the first change found is highlighted.  You click the Accept button to incorporate the edit in the document.  The selection automatically jumps to the next change - which you want to accept, so you click Accept.  To reject an edit, you click the Reject button.  The Accept All and Reject All buttons allow you accept or reject all the changes made to the document.  While the Undo button allows you to undo the last change made.  When you have checked the document, you click the Close button to return to the document.  And you turn off tracking by double-clicking the Track Changes option on the status bar.

11 OF 12 (11-12 ROUND TRIPPING AND TEMPLATES)

With its support for round tripping, Word allows all sorts of users to collaborate on documents, including users who only have a web browser.  Round tripping means that you can save a Word document as a web page, view and amend it using Internet Explorer, and then you see those changes reflected in the original document.  Let's say that you have a table of figures that you want to save as a web page to the Award Sportswear intranet site.  To do this, you select File - Save as Web Page.  You save the document to the intranet site by browsing to the location of the site and clicking the Save button.  Suppose that you are later browsing the intranet site using Internet Explorer.  You decide to change the document using the browser, which involves changing the HTML source code, so you right-click the document and select View Source.  The document opens in a text editor and you make the changes you require to the document.  You save the edited document to the same location and overwrite the existing file.  You refresh the document in your browser.  And you see that the changes are reflected in the browser.  When you open the HTML document in Word, you can see the changes made in the browser have been 'round tripped' back to Word.  And - if you saved the original document as a Word document as well as a web page - the Word document ensures that you will continue to have a backup copy of the data should another user make unauthorized changes.
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You can share a template within a workgroup and set the location for the templates displayed when you choose to create a new document.  This allows all users in the workgroup to use the same custom template.  To keep unauthorized changes from being made to a custom template, a systems administrator needs to make it read only or store it on a server with limited permissions.  Let's say that your workgroup shares a custom template called Stylus 1.0.  You set the default location of a workgroup template by selecting the Tools menu.  And then you select the Options menu option.  You click the File Locations tab.  And you can see the list of default storage locations and search paths for documents, templates, and other items - such as clip art.  You can set the location for the templates displayed when you choose to create a new document.  You select the Workgroup templates option and you click Modify.  You navigate to the folder that contains your workgroup template and then you click OK.  All future templates you create for a workgroup should be saved to the same location.  The file location is now reflected in the Options dialog box and you click OK to close the dialog box.  The template is saved and is available when a new file is created.

END OF COLLABORATING WITH WORKGROUPS

SUMMARY:

You have seen how to work collaboratively on Word documents.  

Using the comments feature, you can add notes, suggestions, and queries to Word documents without changing the original text. You can also insert sound comments in Word documents.   When you add a comment, you type it in the comment pane. Each comment has a unique number. This reference number is placed beside the commented text, which is highlighted in yellow. When you hover the pointer over the highlighted text, the comment is displayed in a screentip.   If you want to view all the comments in a document at the same time, you use the comment pane.  You can prevent users from making unauthorized changes to Word documents. Passwords to open or edit a document can be applied. And you can make a document read only. A read-only document can be opened and changed but it can only be saved under a different filename.  Versions in Word allow you to save and manage multiple versions of a document in a single file. When you save multiple versions of a document, you can open, print, and delete the earlier versions. Versions also save hard disk space because only the changes made to a document are saved when you save a version, not the whole document.  Tracking allows you to compare an edited document with the original document by marking the differences in the edited document. You can view changes made to a document by individual reviewers because their changes are marked in different colors. After viewing the changes, you can then choose to accept or reject those changes.  Workgroup editing and collaboration allows you to share and make changes to Office documents. For example, you can use round tripping to share and collaborate on documents. Round tripping allows you to save a Word document as a web page, to view the document in Internet Explorer and make changes to it, and then to see those changes reflected in the original document.  Workgroup collaboration also allows you to share a common workgroup template across the network. A systems administrator should set and manage the location of shared templates.

UNIT TEST:

1. Which of the following about how comments are identified are true?

a. They each have an individual six-digit code

b. They each have the reviewer’s full name

c. They are each marked in different colored highlighting

d. They each have an individual number

e. They each have a reviewer’s initials

2. Can you delete an existing comment from within the comment pane?

a. Yes

b. No

3. Which of the following are true of sound comments?

a. A sound comment is represented as an icon in the document

b. Sound objects are displayed in the comment pane

c. Sound comments must be less than 5 seconds

4. Which of the following statements are true regarding setting passwords on Word documents?

a. You can apply a password to open a document

b. You can apply a password to send a document by e-mail

c. You can apply a password to modify a document

d. You can apply a password to print a document

5. How many characters can a password contain?

a. 5

b. 10

c. 15

d. 25

6. Which of the following is true of saving a file with a password as a web page?

a. Passwords must be changed to 6 characters in length

b. Passwords get a ‘WWW’ prefix

c. Passwords are disabled

d. Passwords apply unchanged

7. Which of the following statements are true of version control in Word?

a. Versions of a document are complete documents in their own right

b. When you save a version, you save only the changes made to a document

c. Tracking allows you to either accept or reject changes made to a document

d. When you track changes to a document, changes made by different reviewers are identically colored

8. Which of the following information is displayed to you when you view the versions of a document?

a. The name of the reviewer who saved the version

b. A description of the version

c. The author of the original document

d. Keywords for the version

e. The date and time the version was made

9. Which of the following happens to the changes made in Internet Explorer to a document first saved as a web page in Word when it is opened again in Word?

a. The changes are lost

b. The changes are saved as an attached file

c. The changes are saved

d. The changes are saved as an embedded object

10. In which of the following ways can a systems administrator ensure that unauthorized changes are not made to the custom template shared by a workgroup?

a. Create multiple copies of the template on different servers

b. Make the template read only

c. Store it on a server with limited permissions

d. Move the template to another server

e. Make the template a hidden file

11. Which of the following affect the choice of templates available when creating a new document?

a. You personalized menus setting

b. Your file locations settings

c. You macro library

d. Your customized toolbars

ANSWERS:

1. d & e

2. No***

3. a

4. a & c

5. c

6. c

7. b & c

8. a, b & e

9. c

10. b & c***

11. b

